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1 Introduction 

The TSL2520 evaluation kit comes with everything needed to evaluate the TSL2520. The device 

features highly sensitive digital ambient light sensing (ALS). 

1.1 Kit Content 

Figure 1:  

Evaluation Kit Contents 

 

 

No. Item Description 

1 TSL2520 Daughter Card PCB with TSL2520 sensor installed 

2 EVM Controller Board Used to communicate USB to I2C  

3 USB Cable (A to Micro-B) Connects EVM controller to PC 

4 Flash Drive Include application installer and documents 

 

1.2 Ordering Information 

 

Ordering Code Description 

TSL2520 EVM 
TSL2520 Highly Sensitive Ambient Light Sensor 
Evaluation Kit 
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2 Getting Started 

The software should be installed prior to connecting any hardware to the computer. Follow the 

instructions found in the Quick Start Guide (QSG). This loads the required driver for the USB interface 

and the device’s graphical user interface (GUI).  

The balance of this document identifies and describes the controls available on the GUI. In 

combination with the TSL2520 datasheet, the QSG and application notes available on the ams 

website, www.ams.com, there should be enough information to allow evaluation of the TSL2520 

device. 
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3 Hardware Description 

The hardware consists of the EVM Controller, the TSL2520 EVM daughter card, and a USB interface 

cable. The EVM controller board provides power and I2C communication to the daughter card through 

a seven-pin connector. When the EVM controller is connected to the PC through USB, a green LED 

light on power up to indicate the system is getting power. 

For schematics, layout and BOM information please see the documents included with the install 

located in the TSL2520 EVM folder (All Programs -> ams -> TSL2520 EVM -> Documents).  

Figure 2:  

Evaluation Kit Hardware 
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4 Software Description 

The main window (Figure 3) contains the system menus, system level controls, device information and 

logging status. The Configuration tab contains controls to setup ALS detection parameters. ALS tab 

display ALS data and Mod Gain data. The ALS tab contains a plotting area in which raw ALS data is 

drawn. The application polls the ALS raw data continuously.  

Figure 3:  

GUI Main Window 

 

4.1 Connect Software to Hardware 

On startup, the software automatically connects to the hardware. On successful initialization, the 

software displays a main window, containing controls pertinent to the connected device. If the software 

detects an error, an error window appears. If “Device not found or is unsupported” appears, verify the 

correct daughterboard is properly connected to the EVM controller board. If “Cannot connect to EVM 

board” appears, verify the USB cable is connected. When the EVM controller board is connected to 

the USB, a green LED lights on power up to indicate the USB cable is connected and providing power 

to the system. The LED will remain lit until the any software application opens the controller. The light 

will then be switched off so that it will not interfere with any light measurements. 

If the EVM board disconnects from the USB bus while the program is running, it displays an error 

message and then terminates.  Reconnect the EVM board and restart the program. 
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4.2 System Menus 

At the top of the window there are pull-down menus labeled “File”, “Log”, and “Help”. The File menu 

provides basic application-level control. The Log menu controls the logging function, and the Help 

menu provides version and copyright information for the application. 

4.2.1 File Menu 

The File menu contains the following functions: 

Figure 4:  

File Menu 

 

 

The Reread Registers function forces the program to re-read all of the control registers from the 

device and display them on the screen. This does not read the output data, because the program 

reads those registers continually while it is running. 

The Lux Coefficients menu is not implemented in the current software. 

Click on the Exit command to close the main window and terminate the application. Any unsaved log 

data is cleared from memory. The application can also be close by clicking the red “X” in the upper 

right hand corner. 

4.2.2 Log Menu 

The Log menu controls the logging function and saves the log data to a file. Log data accumulates in 

memory until discarded or written to a data file. 

Figure 5:  

Log Menu 

 

 

 

http://www.ams.com/Document-Feedback
http://ams.com


 

 Document Feedback TSL2520 
  Software Description 

 

 
Eval Kit Manual • PUBLIC  
UG001000 • v1-00 • 2020-Dec-14 16 │ 8 

 

Click Start Logging to start the logging function. Each time the program polls the output information 

from the device, it creates a new log entry showing the raw data values, the values of various control 

registers, and the values entered by the user into the text fields near the bottom right corner of the 

window. 

Click Stop Logging to stop the logging function. Once logging stops, the user may store the data in a 

file, or continue collecting additional data by clicking Start Logging again. 

The Log a Single Entry command causes logging to start, collect one single entry, and immediately 

stop again. This function is not available when logging is already running. 

Click Clear Log to discard any previously collected data. If there is data in memory, which has not 

been saved to disk, this function displays a prompt asking to verify it is OK to discard the data. If the 

log is active when this function executes, the log continues running after the existing data is discarded. 

Click Save Log to save the collected log data to a csv file. This stops the logging function, if it is 

active, and displays a file dialog box to specify where to store the logged data. The Log Status and 

Control Information section below describes the default file name, but you may change the file name if 

desired. 

4.2.3 Help Menu 

The Help menu contains a single function: About. 

Figure 6:  

Help Menu 

 

 

The About function displays a dialog box (Figure 7) showing the version and copyright information for 

the application and library. Click the OK button to close this window and continue. 
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Figure 7:  

About Window 

 

4.3 System Level Controls 

Immediately below the top menu bar there are checkboxes used to control the system level functions 

of the TSL2520 device.  

The Power On checkbox controls the PON function of the TSL2520. When this box is checked, the 

power is on and the device is running measurements according the settings in the Configuration tab. 

At this time, the Configuration tab is disabled to prevent users to change the settings while the 

measurement is on going. When this box is unchecked, the power is off and the device does not 

operate. The Configuration tab is enabled and you can change the controls to setup the parameters 

for next running. 

The ALS Enable checkbox controls the AEN function of the TSL2520. When this box is checked, the 

ALS detection is enabled. 

4.4 Auto Polling 

The application automatically polls the TSL2520 raw data if enabled. The Poll Interval at the right 

upper corner of the form displays the actually time between reads of the device. The control “Poll 

Interval” in the middle bottom of the form let the user set the desired polling interval. 
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4.5 Device ID Information 

The lower left corner of the window displays the ID number of the EVM Controller board and identifies 

the device being used. 

4.6 Log Status and Control Information 

The lower right corner of the window contains status information and controls for the logging function: 

Figure 8:  

Logging Status 

 

 

This section contains text boxes that are stored in the log file data and used to build the file name for 

the log file. If the data in these fields are changed, the new values are stored with any new data 

logged. The default file name is based on these values at the time the log file is written. If nothing is 

entered in these boxes they default to a period (“.”). 

Sample default file name: 

TSL2520_1-2-3_Log_HH_MM_SS.csv 

  From Application 

  From User Input 

The Count value displayed is a count of the number of samples currently in the log buffer. 

The Elapsed Time value indicates the elapsed time since data logging started. 

The numeric box in the bottom right-hand corner sets a limit to the size of the collected dataset. You 

may select a value from the pull-down list, or enter a value manually.  When the number of entries in 

the log reaches this value, the program will automatically stop logging and display a file dialog box to 

specify where to store the logged data. You may change the file name if desired.  The maximum value 

that may be entered in this field is 32000. 
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4.7 “Configuration” Tab 

The main portion of the screen contains a tab labeled Configuration.  

Figure 9 :  

Configuration Tab 

 

 

4.7.1 Configuration Controls 

The SAMPLE TIME control sets the measurement time of the step for ALS measurements. 

The ALS group box contains controls relating the flicker detection:  

● ALS_NR_SAMPLES control defines the number of samples for one ALS measurement.  

● ALS Integration Time control displays the integration time for one ALS measurement. 

The Calibration group box contains the following controls: 

● CALIB_NTH_ITERATION control sets the repeat rate of calibration execution in measurement 

sequencer rounds. The values are from 0 to 255.  

● Autozero at nth iteration check box enables auto zero calibration during nth iteration 

calibration if checked. 

● OSC_CALIB control defines calibration mode. The available options are “0 disabled”, “1 after 

pon”, and “2 always on”. 

● At VSYNC Frequency sets VSYNC frequency. The available values are 60HZ, 90HZ and 

120HZ.    
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The Modulators group box contains controls to setup all gains: 

● Gain Clear 0 dropdown combo box sets the gain for channel 0 (clear detection). The choices 

are 1/2x, 1x, 2x, 4x, 8x, 16x, 32x, 64x, 128x, 256x, 512x, 1024x, 2048x, and 4096x. 

● Gain IR 1 dropdown combo box sets the gain for channel 1 (IR detection). The choices are 

1/2x, 1x, 2x, 4x, 8x, 16x, 32x, 64x, 128x, 256x, 512x, 1024x, 2048x, and 4096. 

● AGC group box has two check boxes. One is check box Prediction for enabling the predict 

AGC function for all steps of the sequence if checked. Another one Saturation check box 

enables analog saturation AGC if checked. 

● Residual check box enables a residual measurement on all modulators if checked. 

● AGC_NR_SAMPLES defines the number of samples for every AGC measurement. The values 

are from 0 to 2047. 

● AGC Integration Time displays the AGC integration time. 

The Sequencer group box contains controls relating the wait function: 

● MOD_TRIGGER_TIMMING defines the repeat rate of modulator/sequencer measurements. 

The available selections are “0 off”, “1 normal = 2.84 ms”, “2 long =45.51 ms”, “3 fast = 88.89 

us”, “4 fastlong =1.42 ms”, “5 vsync”, “6 reserved0” and “7 reserved1”.  

● WTIME specifies the time to wait between measurement steps. The values are from 0 to 255.  

4.8  “ALS” Tab 

The main portion of the screen contains a tab labeled ALS. It displays measurement data. 

Figure 10 :  

ALS Tab 
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4.8.1 ALS Group Box 

● The ALS Integration Time. 

● Clear 0 data counts. 

● IR 1 data counts. 

● Clear 0 gain value. 

● IR 1 gain value. 

● Clear 0 Saturation status: Green color means no saturation happened. Red otherwise. 

● IR 1 Saturation status: Green color means no saturation happened. Red otherwise. 

● Lux: Lux calculation is not implement in the GUI. 

4.8.2 ALS Data Plot 

The remaining portion of the ALS tab is used to display a running plot of the collected ALS values. The 

last 350 values are collected and plotted on the graph. As additional values are added, the old values 

will be deleted from the left side of the graph. To start the plotting function, check the Enable Plot 

checkbox and select the 0, 1 checkboxes. 

Figure 11:  

ALS Data Plot 

 

 

The scale of the Y-axis of the plot can be adjusted by clicking on the small up and down arrows at the 

top left corner of the plot. The scale can be set to any power of 2 from 64 through 65536. 

Click the Clear Plot button to discard the current data and continue plotting the new data. Note if the 

Clear Plot button is clicked while the plot is disabled, the data is discarded, but the actual plot will not 

be updated until the plot function is re-enabled. 
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5 Resources 

For additional information regarding the TSL2520, please refer to the datasheet. For information 

regarding the installation of the TSL2520 EVM host application software please refer to the TSL2520 

EVM Quick Start Guide. 

Designer’s Notebooks dealing with various aspects of optical measurement and optical measurement 

applications are available. All content is available on the ams website www.ams.com. 

 

 
For further information, please refer to the following documents: 

 

● TSL2520 Datasheet 

● TSL2520 EVM Quick Start Guide (QSG) 

● TSL2520 EVM User’s Guide (this document) 

● TSL2520 EVM Schematic Layout 
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6 Revision Information 

 

Changes from previous version to current revision v1-00 Page 

Initial Release  

  

  

  

  

  

  

 
● Page and figure numbers for the previous version may differ from page and figure numbers in the current revision. 

● Correction of typographical errors is not explicitly mentioned. 
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7 Legal Information 

Copyrights & Disclaimer 

Copyright ams AG, Tobelbader Strasse 30, 8141 Premstaetten, Austria-Europe. Trademarks Registered. All rights reserved. 
The material herein may not be reproduced, adapted, merged, translated, stored, or used without the prior written consent of the 
copyright owner. 

Demo Kits, Evaluation Kits and Reference Designs are provided to recipient on an “as is” basis for demonstration and 
evaluation purposes only and are not considered to be finished end-products intended and fit for general consumer use, 
commercial applications and applications with special requirements such as but not limited to medical equipment or automotive 
applications. Demo Kits, Evaluation Kits and Reference Designs have not been tested for compliance with electromagnetic 
compatibility (EMC) standards and directives, unless otherwise specified. Demo Kits, Evaluation Kits and Reference Designs 
shall be used by qualified personnel only. 

ams AG reserves the right to change functionality and price of Demo Kits, Evaluation Kits and Reference Designs at any time 
and without notice. 

Any express or implied warranties, including, but not limited to the implied warranties of merchantability and fitness for a 
particular purpose are disclaimed. Any claims and demands and any direct, indirect, incidental, special, exemplary or 
consequential damages arising from the inadequacy of the provided Demo Kits, Evaluation Kits and Reference Designs or 
incurred losses of any kind (e.g. loss of use, data or profits or business interruption however caused) as a consequence of their 
use are excluded. 

ams AG shall not be liable to recipient or any third party for any damages, including but not limited to personal injury, property 
damage, loss of profits, loss of use, interruption of business or indirect, special, incidental or consequential damages, of any 
kind, in connection with or arising out of the furnishing, performance or use of the technical data herein. No obligation or liability 
to recipient or any third party shall arise or flow out of ams AG rendering of technical or other services. 

 

RoHS Compliant & ams Green Statement 

RoHS Compliant: The term RoHS compliant means that ams AG products fully comply with current RoHS directives. Our 
semiconductor products do not contain any chemicals for all 6 substance categories plus additional 4 substance categories (per 
amendment EU 2015/863), including the requirement that lead not exceed 0.1% by weight in homogeneous materials. Where 
designed to be soldered at high temperatures, RoHS compliant products are suitable for use in specified lead-free processes.  

ams Green (RoHS compliant and no Sb/Br/Cl): ams Green defines that in addition to RoHS compliance, our products are free 
of Bromine (Br) and Antimony (Sb) based flame retardants (Br or Sb do not exceed 0.1% by weight in homogeneous material) 
and do not contain Chlorine (Cl not exceed 0.1% by weight in homogeneous material). 

Important Information: The information provided in this statement represents ams AG knowledge and belief as of the date that 
it is provided. ams AG bases its knowledge and belief on information provided by third parties, and makes no representation or 
warranty as to the accuracy of such information. Efforts are underway to better integrate information from third parties. ams AG 
has taken and continues to take reasonable steps to provide representative and accurate information but may not have 
conducted destructive testing or chemical analysis on incoming materials and chemicals. ams AG and ams AG suppliers 
consider certain information to be proprietary, and thus CAS numbers and other limited information may not be available for 
release. 

 

Headquarters 

ams AG 

Tobelbader Strasse 30 

8141 Premstaetten 

Austria, Europe 

Tel: +43 (0) 3136 500 0 

Please visit our website at www.ams.com 

Buy our products or get free samples online at www.ams.com/Products 

Technical Support is available at www.ams.com/Technical-Support 

Provide feedback about this document at www.ams.com/Document-Feedback 

For sales offices, distributors and representatives go to www.ams.com/Contact 

For further information and requests, e-mail us at ams_sales@ams.com 
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